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Le informazioni contenute nel presente documento non hanno natura contrattuale e possono essere 

soggette a modifiche senza preavviso. 

 

Il software descritto nel presente manuale viene venduto con un contratto di licenza. Il software può essere 

utilizzato, copiato o riprodotto in base ai termini e alle condizioni del contratto. 

 

Il presente manuale non può essere copiato, riprodotto o trasmesso, in tutto o in parte, in nessuna forma, 

su nessun supporto e per nessuno scopo che si discosti dall'utilizzo da parte dell'acquirente, senza 

autorizzazione scritta di Braton Groupe sarl. 
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Informazioni su questo manuale 

Convenzioni tipografiche 

Nel presente manuale vengono utilizzate diverse convenzioni per distinguere vari tipi di informazioni: 

 I termini dell'interfaccia, come i comandi, vengono visualizzati in grassetto. 

 I tasti sono scritti in maiuscolo. Ad esempio: "Premere il tasto MAIUSC". 

 Gli elenchi numerati indicano una procedura da seguire. 

 Quando accanto a un paragrafo compare la congiunzione -oppure-, significa che è possibile scegliere 

una procedura alternativa per svolgere un determinato compito. 

 Quando un comando di menu include dei sottomenu, il nome del menu seguito dal comando da 

selezionare compare in grassetto. Quindi, ''Scegliere File > Apri" significa selezionare il menu File, 

quindi il comando Apri. 

Informazioni sul prodotto 

Alcune funzionalità descritte nel manuale potrebbero non essere disponibili per il prodotto. 

Fare riferimento alle specifiche tecniche fornite con il prodotto per un elenco completo delle funzionalità 

specifiche del software. 





 

 

Introduzione 

Benvenuto! 

Il pacchetto software per l'identificazione automatica che ha appena acquistato è leader sul mercato mondiale. 

Presentazione 

Questo software per la creazione delle etichette consente di creare e modificare rapidamente etichette 

complesse, integrando tutti i dati elettronici aziendali, garantendo la totale sicurezza di tutti i sistemi. 

L'applicazione soddisfa tutti i requisiti di identificazione automatica e si integra perfettamente nel processo di 

produzione. 

Nel mercato attuale è la soluzione più facile e intuitiva per tutte le aziende che operano nell'inserimento, nella 

raccolta e nella modifica in tempo reale dei complessi dati dei codici a barre. 

Descrizione del prodotto 

Il prodotto include i seguenti componenti: 

 CD di installazione. 

 Documentazione completa in formato elettronico. 

 Contratto di licenza e scheda di registrazione. 

 Una chiave di protezione elettronica (chiave software) o fisica (chiave hardware). 

Nota: Il file Release.txt contiene le informazioni più aggiornate sul software. Tali informazioni sostituiscono 

quelle contenute nel presente manuale. 

Requisiti di sistema 

I requisiti software e hardware per eseguire l'applicazione sono simili a quelli necessari per la maggior parte 

delle applicazioni Windows™: 

 Sistema operativo Windows a 32 o 64 bit: 7, XP, Server 2003 o 2008 oppure Vista. 

 Computer con 1 GB di RAM (a seconda del sistema). 

 Disco rigido con almeno 500 MB di spazio libero (a seconda delle opzioni di installazione). 

 CPU: 2 GHz minimo. 

 Scheda grafica: Directx 9 minimo. 

 Diritti di accesso al computer come amministratore durante l'installazione. 

Nota: Per scongiurare qualsiasi problema di compatibilità, rimuovere tutte le versioni precedenti di questo 

software eventualmente installate nel sistema. 

Nota: Il file Release.txt contiene le informazioni più aggiornate sul software. Tali informazioni sostituiscono 

quelle contenute nel presente manuale. 
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Installazione 

Nota: Prima di installare il software, salvare il proprio lavoro e chiudere tutti i programmi. 

Prima di eseguire il programma di installazione, verificare la configurazione del proprio PC. 

1. Posizionare il CD di installazione nel drive appropriato. Viene visualizzata la finestra di installazione. 

Se il CD non parte automaticamente: 

2. Selezionare Start > Esegui , quindi digitare la lettera del drive del CD-ROM seguita da index.hta (ad 

esempio: D:\index.hta). 

3. Selezionare il prodotto da installare, fare clic sul pulsante Install e seguire le istruzioni che vengono 

visualizzate sullo schermo. 

Installazione del software 

Selezionare la configurazione del programma che si desidera installare, quindi fare clic su Next. 

 

Prima di eseguire il processo di installazione, assicurarsi di avere i diritti di amministratore locale. 
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Protezione della licenza 

Il software può essere protetto grazie a una chiave software (un codice di attivazione) o una chiave fisica (una 

chiave hardware). 

La chiave hardware è un piccolo dispositivo elettronico che viene inserito nella porta parallela o USB del PC 

prima di avviare il software. Senza la chiave hardware di protezione del software, il programma viene eseguito 

in modalità "valutazione". In questa modalità non è possibile salvare le etichette, la lettera "e" viene sostituita 

da "x", il valore "0" con "5" e le immagini stampate sono barrate. 

La chiave software è un codice che viene richiesto dalla procedura guidata di attivazione quando si avvia il 

software per la prima volta o finché si esegue una versione di prova. Se si utilizza una chiave software di prova, 

si hanno a disposizione 100 esecuzioni o 30 giorni per provare il prodotto con tutte le funzionalità disponibili. 

Nota: Quando viene avviata l’applicazione, viene visualizzata una finestra di dialogo che fornisce le istruzioni 

necessarie nel caso in cui la chiave di protezione del software non corrisponda alla versione del prodotto di cui 

si è in possesso. 

È necessario innanzitutto eseguire l’installazione del software di etichettatura e quindi attivare la chiave di 

protezione o collegarla al computer. 

Protezione con chiave hardware 

Se si è acquistato il software con una chiave hardware, è possibile scegliere tra una chiave per porta USB o 
parallela. 

Collegamento della chiave parallela: 

 

Se sulla stessa porta parallela viene utilizzata una stampante, è sufficiente inserirla nella chiave di protezione 

del software. In tal caso può essere necessario accendere la stampante per consentire il riconoscimento della 

chiave di protezione del software. 

Collegamento della chiave USB: 

 

Se si utilizza una chiave USB e si dispone di varie porte USB, la chiave può essere inserita in una qualunque 

delle porte. Se non si ha a disposizione una porta USB, è possibile utilizzare un hub di espansione USB. I 

dispositivi USB sono hot-swap, quindi possono essere inseriti e disinseriti dal bus in qualunque momento, senza 

la necessità di riavviare il PC.  
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Nota: I driver possono essere installati mentre l’applicazione è in esecuzione. Tuttavia, perché le modifiche 
abbiano effetto sarà necessario riavviare il software per l'etichettatura. 

Le chiavi hardware USB non sono supportate dai sistemi operativi Windows 95 e Windows NT4. 

Messaggi di errori all'avvio del software 

Se all’avvio del software viene visualizzato un messaggio di errore, verificare quanto segue: 

 I diritti di amministrazione. Per il corretto funzionamento della chiave, è necessario disporre dei 

diritti di amministratore sul PC. Se non si dispone di tali diritti, viene visualizzato un messaggio di 

errore all’avvio del software. In questo caso i driver devono essere installati manualmente. 

 Installazione dei driver. Se si incontrano problemi durante l’installazione o se viene visualizzato un 

messaggio di errore all’avvio del software, è necessario installare manualmente i driver. 

 La chiave: Verificare che la chiave connessa funzioni con il software per l'etichettatura. 

 Aggiornamento del driver: Il driver potrebbe non essere aggiornato. Per aggiornarlo, è necessario 

scaricarlo dal sito Web all'indirizzo http://www.aladdin.com/support/hasp/enduser.aspx 

Protezione con chiave software 

Dopo aver installato il software per etichettatura, verrà avviata l'Activation Wizard che fornisce indicazioni passo 

passo per attivare la protezione tramite chiave software. 

Attivazione della protezione 

Nell'Activation wizard, selezionare Activate e fare clic su Avanti. I metodi di attivazione possibili sono tre: 

Automatico (Internet), via telefono/sito Web e via fax. 

 Attivazione automatica (metodo consigliato) 

1. Selezionare Automatico dalla lista dei metodi di attivazione. Questa opzione consente di attivare la 

chiave software tramite una connessione Internet sicura. Questa è l'opzione più rapida e semplice. 

2. Immettere le informazioni nel modulo Registrazione utente. Tenere presente che i campi 

contrassegnati da asterisco (*) sono obbligatori. Fare clic su OK. 

3. Immettere il codice di attivazione fornito con il prodotto e fare clic su Avanti. 

4. Fare clic su Fine se l'attivazione si è conclusa correttamente. Se si sono verificati dei problemi, 

vengono visualizzati un messaggio che informa che l'attivazione non è riuscita e un errore. 

 Attivazione tramite telefono o sito Web 

1. Selezionare il metodo d'attivazione Telefono. 

2. Immettere il codice di attivazione fornito con il prodotto e fare clic su Avanti. 

3. Chiamare il rivenditore. 

Nota: Sarà richiesto di compilare telefonicamente il modulo User Registration. Tenere a portata di mano le 

informazioni aziendali. 

4. Immettere il Codice di risposta fornito dal rivenditore e fare clic su Avanti. 
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5. Fare clic su Fine se l'attivazione si è conclusa correttamente. Se si sono verificati dei problemi, 

vengono visualizzati un messaggio che informa che l'attivazione non è riuscita e un errore. 

 Attivazione tramite fax 

1. Selezionare il metodo d'attivazione Fax. 

2. Immettere le informazioni nel modulo Registrazione utente. Tenere presente che i campi 

contrassegnati da asterisco (*) sono obbligatori. Fare clic su Avanti. 

3. Immettere il codice di attivazione fornito con il prodotto e fare clic su OK. 

4. Fare clic sul pulsante Crea modulo. Verrà creato un modulo Activation Request contenente tutte le 

informazioni necessarie sull'utente. Tale modulo deve essere inviato via fax o e-mail per ricevere il 

codice di risposta. Utilizzare le informazioni di contatto visualizzate sullo schermo. Fare clic su Avanti. 

5. In attesa di ricevere un Codice di risposta, si può scegliere di avviare il software e di iniziare a 

utilizzarlo, oppure, chiuderlo e tornare alla procedura di attivazione dopo aver ricevuto il codice di 

risposta. 

Una volta ricevuto il codice di risposta, è possibile tornare all'attivazione riavviando la procedura 

guidata. Selezionare il metodo d'attivazione Fax. Fare clic su Avanti fino a raggiungere la schermata 

del punto 5. Scegliere l'opzione Inserire il Codice di risposta. Tutte le opzioni precedentemente 

selezionate nella procedura guidata vengono mantenute. 

6. Immettere il codice di risposta fornito e fare clic su Avanti. 

7. Fare clic su Fine se l'attivazione si è conclusa correttamente. Se si sono verificati dei problemi, 

vengono visualizzati un messaggio che informa che l'attivazione non è riuscita e un errore. 

Installazione manuale del driver della chiave 

Se si desidera installare manualmente il driver della chiave, seguire questa procedura: 

 Selezionare Start, quindi Esegui. 

 Specificare il percorso C:\program files\TKI\9\Common\Tools\Dongle\, quindi digitare il seguente 

comando: \HaspDinst.exe -i 

Nota: Si consiglia di chiudere il software di etichettatura e altre eventuali applicazioni prima di installare il 

driver. 

Avvio del programma 

1. Selezionare Start > Programmi. 

2. Selezionare il nome che è stato dato al gruppo di programmi durante l'installazione (come 

impostazione predefinita, è il nome dell'applicazione). 

Viene visualizzata la finestra principale. 
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Scoperta dell’interfaccia 

Descrizione della finestra principale 

Questa sezione comprende una panoramica generale degli elementi della finestra principale nell'ordine in cui 

vengono visualizzati all'inizio di una sessione di lavoro.  

La barra dei menu 

La barra dei menu contiene le seguenti opzioni: File, Modifica, Visualizza, Oggetto, Origine de dati, 

Strumenti, Finestra e Guida. 

Per aprire un menu 

1. Selezionatelo con il pulsante sinistro del mouse. 

2. Quindi scegliete il comando desiderato. 

Nota : Per accedere a un comando tramite la tastiera, utilizzare i tasti di scelta rapida. Premere ALT seguito 

dalla lettera sottolineata nel nome del menu o del comando. 

Lo spazio di lavoro 

Lo spazio di lavoro è la parte centrale della finestra, posta fra i righelli e le barre di scorrimento. Contiene un 

riquadro che fissa i limiti del documento e include gli oggetti da stampare nonché un'area non stampabile per 

inserire annotazioni e oggetti che non si desidera stampare. 

Il documento 

Quando viene aperta una nuova sessione, il programma visualizza un riquadro nella parte in alto a sinistra della 

finestra. Questo riquadro rappresenta i limiti del documento da stampare.  

Posizionare all'interno del riquadro gli oggetti necessari a creare il documento.  

La barra di stato 

Posizionata nella parte inferiore della finestra, la barra di stato visualizza il nome della stampante selezionata, 

la porta di comunicazione cui è connessa, le coordinate x e y del puntatore del mouse e le dimensioni cx e cy 

dell'oggetto selezionato. 

 

Le barre degli strumenti 

Questi strumenti consentono di eseguire attività di routine più rapidamente rispetto all'uso del mouse. 

 

Selezione degli strumenti: Fate clic sul pulsante che corrisponde allo strumento.  
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La barra del titolo 

La barra del titolo visualizza il nome del software e del documento corrente o "documenton. " nel caso in cui sia 

stato creato un nuovo documento. Consente di spostare la finestra dello spazio di lavoro con il mouse.  

La barra degli strumenti di formattazione del testo 

Questi strumenti consentono di modificare la formattazione di testo e/o di un paragrafo, ad esempio modificare 

il font, la dimensione dei caratteri, le opzioni di stile, l'allineamento e così via. 

 

Per modificare la formattazione: 

1. Selezionare un oggetto nel documento. 

2. Fare clic sulle opzioni desiderate. 

Nota: Tutte queste opzioni sono accessibili anche dalla finestra di dialogo Testo tramite il comando Oggetto > 

Testo. 

La barra degli strumenti Oggetto 

La barra degli strumenti Oggetto visualizza il nome dell'oggetto selezionato e consente di accedere alle 

proprietà di tale oggetto. 

 

La barra degli strumenti Visualizza 

La barra degli strumenti Visualizza offre diverse opzioni di visualizzazione. 

Per modificare la modalità di visualizzazione fare clic sulla modalità desiderata: 

Pulsante Nome dello strumento Funzione 

 
Nome Visualizza i nomi delle variabili. 

 
Dimensione Visualizza la dimensione massima delle variabili. 

 
Contents Visualizza i valori delle variabili. 

 
Modulo Visualizza il modulo. 

 
Visualizza Visualizza le viste Oggetti e Origini dati. 

 
Zoom Consente di aumentare o diminuire il dettaglio degli oggetti 

Nota: Tutte queste opzioni sono accessibili anche dal menu Visualizza. 
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La barra degli strumenti di creazione 

La barra degli strumenti di creazione include diversi pulsanti che rappresentano ognuno uno strumento per 

creare e manipolare oggetti. 

Pulsante Nome dello strumento Funzione 

 
Selection tool Consente di selezionare e manipolare tutti i tipi di oggetto. 

 
Testo Consente di creare testo fisso e variabile. 

 Codici a barre Consente di creare codici a barre fissi e variabili. 

 Immagini Consente di inserire immagini. 

 Oggetti esterni Consente di inserire oggetti esterni all'applicazione. 

 Linee Consente di disegnare linee orizzontali o verticali. 

 Rettangoli Consente di disegnare rettangoli o quadrati. 

 Forme circolari Consente di disegnare forme circolari. 

 Figure libere Consente di disegnare figure libere costituite da linee. 

 Linee diagonal Consente di disegnare linee diagonali. 

 
Rettangoli con angoli arrotondati Consente di disegnare rettangoli con angoli arrotondati. 

 
Figure già pronte Consente di importare nel documento figure già pronte. 

 
Procedure guidate UCC/EAN 128, 

HIBC and Maxicode 

Consente di creare codici a barre con le procedure guidate 

UCC/EAN 128, HIBC e Maxicode. 

 
Plug-ins Consente di creare campi TextArt, ListFields, OCXFields e 

RichText. 

Viste Origini dati e Oggetti   

La vista Origini dati visualizza le origini dati e il numero di variabili associato. È possibile inserire gli oggetti 

variabile semplicemente trascinandoli nel documento. È inoltre possibile aggiungere, eliminare e modificare le 

proprietà delle variabili nel menu di scelta rapida. 

La vista Oggetti visualizza il numero di oggetti creati in base al tipo e alle proprietà quali posizione, altezza e 

larghezza. Questa scheda può essere utilizzata anche per selezionare un oggetto e modificarne la posizione. 
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I tasti con la freccia rivolta verso l'alto e verso il basso consentono di muoversi in su e in giù nella struttura ad 

albero. I simboli + e - consentono di espandere o contrarre l'elenco e di visualizzare l'elenco delle variabili 

associate a ogni origine dati o gli oggetti disponibili per ogni categoria. 

Informazioni sulle origini dati 

Una origine dati contiene una lista di variabili costituita da dati con la stessa origine. 

Quando si seleziona una origine dati, si indica il tipo e la posizione del dato richiesto. I dati possono avere 

origine interna (Data, Contatore) o esterna all'applicaizone (Database, inserimento dati diretto tramite il 

Modulo). 

Le varie origini dati disponibili nella vista Data Sources sono le seguenti: Database, Data, Modulo, Formula, 

Ricerca in tabella, Contatore e Libera. 

Righelli 

I righelli vengono utilizzati per visualizzare la posizione del mouse e per posizionare accuratamente i vari 

oggetti nel documento. Possono essere impostati in pollici o millimetri utilizzando il comando Strumenti > 

Opzioni. 

I righelli consentono di individuare la posizione del puntatore del mouse e posizionare con assoluta precisione 

gli oggetti da includere nel documento. Possono essere configurati in pollici o millimetri utilizzando il comando 

Strumenti > Opzioni > Visualizza. 

 Facendo doppio clic sulla parte sinistra del righello orizzontale si riduce la percentuale di 

visualizzazione. 

 Facendo doppio clic sulla parte destra del righello orizzontale si aumenta la percentuale di 

visualizzazione. 

 È possibile visualizzare il menu di scelta rapida Zoom facendo clic con il pulsante destro del mouse sul 

righello verticale. 
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Pulsante di rotazione 

Se si fa clic su  nella parte in alto a sinistra del documento è possibile ruotare il documento stesso di 90°, 

180°, 270° o 360° sullo schermo. La rotazione a schermo è una funzionalità esclusivamente di visualizzazione, 

non ha alcun effetto sulla stampa. 

Per ruotare un documento: 

 Fare clic sul pulsante di rotazione con il mouse e ruotare il documento di 90° verso sinistra. 

 Fare clic sul pulsante di rotazione con il pulsante destro del mouse e ruotare il documento di 90° verso 

destra. 

Nota: Lo stesso effetto di rotazione del documento può essere ottenuto utilizzando il comando View > 

Orientation o facendo clic sul righello verticale con il pulsante destro del mouse per visualizzare il menu di 

scelta rapida. 

Tavolozza dei colori 

La tavolozza dei colori viene visualizzata nella parte inferiore dello spazio di lavoro e consente di modificare il 

colore degli oggetti del documento (testo, codici a barre, forme ecc.). 

 

Per modificare il colore di un oggetto: 

Selezionare l'oggetto desiderato. 

 Fare clic con il mouse su un colore nella tavolozza per applicarlo a testo, linee o contorni. 

 Fare clic con il pulsante destro del mouse su un colore nella tavolozza per applicarlo allo sfondo. 

Nota: Il pulsante X elimina il colore di sfondo da un oggetto. 

È possibile modificare il colore anche tramite la finestra di dialogo Proprietà. 

 Fare doppio clic su un oggetto. Viene visualizzata la finestra di dialogo Proprietà. 

 Selezionare un colore (di primo piano o di sfondo) nella scheda Carattere. 
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Configurazione dell’ambiente di lavoro 

Scelta della stampante 

Prima di iniziare a creare un documento, è necessario impostare l'ambiente di lavoro. 

Il primo passo consiste nel selezionare la stampante con cui si desidera stampare le etichette. Le stampanti 

non hanno tutte le stesse caratteristiche, di conseguenza sono disponibili opzioni diverse a seconda del modello 

di stampante scelto.  

La seconda fase consiste nell'impostazione delle opzioni dell'ambiente di lavoro, ad esempio la lingua 

dell'interfaccia, l'unità di misura ecc. Tutte le opzioni disponibili verranno esaminate più avanti nel capitolo. 

La fase finale consiste nell'impostazione delle pagine dei documenti, ad esempio nella definizione delle 

dimensioni del documento, dell'orientamento, dei margini ecc. 

Il software di creazione delle etichette consente di stampare con un'ampia gamma di stampanti i cui driver sono 

forniti con il software. È inoltre possibile stampare con una stampante Windows installata in locale sulla 

macchina o sulla rete aziendale. 

È necessario selezionare la stampante prima di iniziare la creazione del documento in quanto la scelta della 

stampante determina la configurazione delle opzioni di pagina, l'uso di diversi font di carattere e così via. 

Selezione di una stampante 

È possibile accedere alla finestra di dialogo Printer selection tramite: 

Il comando File > Seleziona stampante 

-oppure- 

Facendo clic sul pulsante     

-oppure-- 

pressione del tasto F5. 

È possibile accedervi anche facendo clic sul pulsante Stampante nella finestra di dialogo Stampa (F6). 

È necessario selezionare una stampante prima di creare il documento. La scelta della stampante influisce sulle 

opzioni di impostazione, sull'uso dei vari font ecc. 

Stampanti di Windows e stampanti native 

Come abbiamo già visto, il software di creazione delle etichette è in grado di stampare su un'ampia gamma di 

stampanti di Windows e native, sia dirette che a trasferimento termico. 
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Il termine stampante di Windows fa riferimento a qualsiasi stampante installata sul sistema operativo, 

generalmente si tratta di stampanti per ufficio, laser e così via. I lavori di stampa vengono inviati allo spooler 

(coda processi). 

I driver per le stampanti native e a trasferimento termico vengono forniti con il software di creazione delle 

etichette. La stampa su queste stampanti viene gestita direttamente dal software. 

Per selezionare una stampante 

1. Scegliere File > Seleziona stampante. 

È anche possibile fare clic sul pulsante   o premere F5. 

2. Selezionare una stampante dall'elenco. 

3. Fare clic su OK. 

Nota : I driver forniti dall'applicazione sono caratterizzati da un'icona. 

Aggiunta di una stampante 

È possibile accedere alla finestra di dialogo Installazione stampante tramite il comando File > Seleziona 

stampante, e facendo clic su Aggiungi. 

Questa finestra di dialogo consente di aggiungere i driver della stampante forniti con il software. 

Nota: Per aggiungere una stampante di Windows, è necessario utilizzare il Pannello di controllo. 

Per aggiungere una stampante: 

1. Fare clic su File > Seleziona stampante. 

È anche possibile fare clic sul pulsante   o premere F5. 

2. Fare clic su Aggiungi. 

3. Selezionare un tipo e quindi un modello di stampante dall'elenco Modello. 

4. Selezionare la porta di comunicazione (seriale, parallela o file), quindi fare clic su OK. 

Nota: Fare clic sul simbolo (+) accanto al tipo di stampante per visualizzarne i vari modelli. 

Le porte di comunicazione 

Nome 

porta 

Funzione 

COMx Indica le porte di comunicazione seriali. Selezionare il numero della porta seriale cui la stampante 

è connessa. 

LPTx Indica le porte di comunicazione parallele. Selezionare il numero della porta parallela cui la 

stampante è connessa. 

File Selezionare File se si desidera stampare su file. 
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Esempio 

 

Aggiunta di una Zebra 140 su LPT1 

 

1. Scegliere File > Seleziona stampante. 

2. Fare clic su Aggiungi. 

3. Dall'elenco Modello selezionare il gruppo Zebra, quindi b. 

4. Selezionare la porta di comunicazione LPT1, deselezionare la casella Direct access, quindi fare clic su OK. 

Personalizzazione dell'ambiente di lavoro 

Il software offre numerose opzioni di personalizzazione dell'ambiente di lavoro. 

Tali opzioni includono la scelta della lingua dell'interfaccia, dell'unità di misura, del font di visualizzazione delle 

finestre di dialogo, delle cartelle di lavoro e del tasso di conversione delle valute. 

Modifica della lingua dell'interfaccia 

L'interfaccia utente è disponibile in diverse lingue e può essere modificata con facilità.  

1. Scegliere Strumenti > Opzioni. 

2. Fare clic sulla scheda  Visualizza. 

3. Selezionare la lingua. 

4. Fare clic su  OK. 

Nota : Quando si fa clic su OK, tutti i menu, i comandi e i messaggi a video verranno visualizzati nella lingua 

selezionata (fanno eccezione la guida in linea e le finestre di dialogo di Windows, come Apri e Salva con 

nome).   

Modifica delle opzioni di visualizzazione e dell'ambiente di lavoro 

È possibile modificare la lingua dell'interfaccia, l'unità di misura e il font di visualizzazione per le caselle di 

dialogo. Per modificare queste opzioni, utilizzare la scheda Visualizza. 

 Per accedere alla scheda Visualizza, selezionare Strumenti > Opzioni. 

Scelta dell'unità di misura 

L'unità di misura può essere millimetri o pollici. L'impostazione dell'unità di misura modifica i righelli.  

1. Scegliere Strumenti > Opzioni. 

2. Fare clic sulla scheda Visualizza. 

3. Selezionare l'unità di misura desiderata. 

4. Fare clic su OK.  

Modifica del font di visualizzazione delle finestre di dialogo 

1. Scegliere Strumenti > Opzioni. 

2. Fare clic sulla scheda Visualizza. 
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3. Nel campo Font di visualizzazione, fare clic su . 

4. Selezionare il font. 

5. Fare clic su OK. 

Modifica della scala delle griglie 

La scala delle griglie, utilizzata per allineare gli oggetti, può essere modificata o disabilitata.   

1. Scegliere Strumenti > Opzioni. 

2. Fare clic sulla scheda Griglia. 

-oppure- 

Fare doppio clic sul righello verticale per accedere direttamente alla scheda Griglia. 

3. Selezionare la scala desiderata. 

4. Fare clic sull'opzione Visualizza. 

5. Fare clic su OK. 

Nota : L'unità di misura utilizzata per la scala delle griglie viene definita nella scheda Visualizza.  

Definizione del tasso di conversione  

Il tasso di conversione definito nella finestra viene utilizzato nelle formule eurotocurrency (daeuroavaluta) e 

currencytoeuro (davalutaaeuro). 

1. Scegliere Strumenti > Opzioni. 

2. Fare clic sulla scheda Altre. 

3. Immettere il tasso di conversione nella finestra. 

Note: Il tasso di conversione predefinito è tra il franco francese e l'euro. 

Definizione della cartella di lavoro 

La prima volta in cui vengono aperte le finestre di dialogo Apri e Salva con nome dopo aver avviato il 

software, la cartella Documenti viene selezionata come cartella di lavoro predefinita. 

1. Scegliere Strumenti > Opzioni quindi la scheda Cartelle predefinite. 

2. Fare clic sulla colonna del Percorso per modificare la cartella di lavoro predefinita. 

-oppure-  

Fare clic sul pulsante  e selezionare la nuova cartella di lavoro predefinita. Modificare il percorso 

nella colonna Percorso 

3. Fare clic su OK. 
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Impostazione delle pagine:  

Formattazione di un documento 

I modelli dei documenti vengono creati e modificati nella finestra di dialogo Imposta pagina 

Formattare un documento significa impostare le dimensioni della pagina, l'orientamento, il numero di etichette 

per riga e per colonna, la dimensione del documento, i margini e la distanza fra le etichette. È possibile creare i 

propri modelli di documento e salvarli per un utilizzo futuro. 

Nota: Prima di creare un modello di documenti, è necessario scegliere il modello di stampante che si utilizzerà 

per produrre i documenti. Scegliere File > Seleziona stampante. 

Definire il formato della pagina nella finestra di dialogo Imposta pagina. Vengono così aggiornate le 

impostazioni della stampante. Il software non utilizza le impostazioni della pagina definite nella finestra di 

dialogo Configura la stampante.  

1. Scegliere File > Imposta pagina. 

-oppure- 

Fare clic sul pulsante . 

2. Fare clic sulla scheda Etichetta e immettere la dimensione e il numero delle etichette. 

3. Fare clic sulla scheda Pagina e selezionare la dimensione e l'orientamento della pagina. 

4. Digitare i valori desiderati nella scheda Margini. La scheda Modello consente di salvare i modelli 

personalizzati. 

5. Fare clic su OK. 

Nota : Quando i parametri immessi sono incompatibili con la dimensione del modello, viene visualizzato un 

messaggio di errore. 

 

Esempio 

 

Creazione e definizione dell'impostazione della pagina per un modello personalizzato 

 

1. Creare un nuovo documento. 

2. Selezionare la stampante di Windows generica. 

3. Scegliere File > Imposta pagina. 

 - oppure - 

 Fare clic sul pulsante . 

4. Fare clic sulla scheda Etichetta e immettere i seguenti valori: 

   Larghezza e Altezza: 30/30 

   Numero per etichette: 

      Per riga: 2 

      Per colonna: 3 

   Raggio angolo 0 

5. Fare clic sulla scheda Pagina e immettere i seguenti valori: 
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 Page sizing: Dimensionamento automatico 

6. Fare clic sulla scheda Margini e immettere i seguenti valori: 

   Margini: 

      A sinistra: 10 

      In alto: 10 

   Spazio: 

      Tra colonna: 5 

      Tra righe: 5 

7. Fare clic sulla scheda Modello e immettere i seguenti valori: 

   Tipo: Family 

   Nome: Layout1 

8. Fare clic su OK quindi salvare l'etichetta come TEST1.LAB. 

Creazione di una custodia per CD: impostazione della pagina e creazione di un modello 

personalizzato 

1. Creare un nuovo documento e denominarlo FRONT. 

  

2. Selezionare la stampante. 

  

3. Scegliere Strumenti > Opzioni, fare clic sulla scheda Visualizza e selezionare Millimetri come unità 

di misura. Fare clic su OK. 

  

4. Scegliere File > Imposta pagina 

- oppure - 

Fare clic sul pulsante  . 

  

5. Fare clic sulla scheda Etichetta e immettere i seguenti valori: 

 Larghezza e Altezza: 120, 

 Raggio angolo: 100, 

 Numero per etichette: 

 Per riga: 1, 

 Per colonna: 2  

6. Fare clic sulla scheda Pagina e selezionare i seguenti valori: 

 Dimensione pagina: A4, 

 Orizzontale. 

7. Fare clic sulla scheda Margini e immettere i seguenti valori: 

 Margini: 

 A sinistra: 40, 

 In alto: 10, 

 Spazzio: 

 Tra righe: 15. 
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8. Fare clic sulla scheda Modello e immettere i seguenti valori: 

 Type: Jaquette, 

 Name: CDx2.  

9. Fare clic su OK. 

Note: La stampante utilizzata in questo esempio è una stampante di Windows™. Se si desidera utilizzare una 

stampante termica, è possibile che vengano visualizzati messaggi di errore durante l'impostazione della pagina. 

Sarà quindi necessario modificare i valori suggeriti nell'esempio poiché, come abbiamo già visto, la scelta della 

stampante influisce su alcune impostazioni. 

Eliminazione di un modello personalizzato 

Se un modello creato non è più necessario, è possibile eliminarlo. 

Per eliminare un modello personalizzato: 

1. Scegliere File > Imposta pagina. 

-oppure- 

Fare clic sul pulsante . 

2. Nella scheda Modello, selezionare il modello dagli elenchi Tipo e Nome. 

3. Fare clic sul pulsante Rimuovi. 
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Creazione e manipolazione di oggetti 

La creazione di oggetti fissi implica l'inserimento nel documento di oggetti quali testo, codici a barre, immagini, 

linee, rettangoli e cerchi. 

Creazione di oggetti 

È possibile creare in modo semplice e veloce un oggetto (codice a barre, immagine, testo, disegni ecc.) nel 

documento utilizzando: 

 La barra degli strumenti di creazione, 

 

- oppure - 

  

 il menu Oggetto. 

Nota: l'applicazione dà automaticamente un nome ad ogni oggetti creato. Una volta selezionato l'oggetto, il 

nome viene visualizzato nella vista Oggetti e nella barra degli strumenti Oggetto. 

È possibile creare un oggetto utilizzando una delle seguenti opzioni: 

 Creazione modalità diretta: 

1. Fare clic direttamente sull'oggetto o l'icona che si desidera inserire nel documento. 

2. Fare clic sulla posizione in cui si desidera mettere l'etichetta. 

 

-oppure- 

 Creazione modalità guidata (secondo i requisiti di utilizzo): 

1. Fare clic sul pulsante del menu dell'oggetto. Viene visualizzato un sottomenu con l'elenco di azioni che 

è possibile assegnare all'oggetto (Oggetto fisso, Procedura guidata, Nuova origine dati, Usa una origine 

dati esistente). 

2. Selezionare l'azione desiderata. 

3. Fare clic sulla posizione in cui si desidera mettere l'etichetta. 

Modifica di un oggetto 

Potete modificare un oggetto utilizzando: 

 la barra degli strumenti, la barra degli strumenti di formattazione, la barra degli strumenti di 

allineamento, ecc. 

 Fate doppio clic sull'oggetto, 

  Oggetti vista > Proprietà... 
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La funzione Trascina (Per trascinare, fate clic sulla voce e trascinate la voce fino alla posizione desiderata 

tenendo premuto il pulsante sinistro del mouse.) cviene utilizzata per eseguire operazioni comuni (Creare degli 

oggetti di testo o immagini, trascinando dal Browser Windows dei file di testo e dei file grafici supportati 

dall'applicazione oppure creare degli oggetti variabili trascinando le variabili dalla scheda Origini dati) 

Creazione di un oggetto di testo 

Un oggetto di tipo testo può essere costituito da un carattere, una parola o un intero paragrafo. 

È possibile definire lo stile del carattere e il formato del paragrafo utilizzando la barra degli strumenti di 

formattazione del testo oppure la finestra di dialogo Testo. 

Per creare un oggetto di testo: 

1. Dalla barra degli strumenti Creazione, fare clic sullo strumento Crea testo . 

- oppure - 

Scegliere Oggetto > Testo. 

2. Fare clic all'interno dello spazio di lavoro oppure sul testo da modificare. 

- oppure - 

Selezionare e trascinare un riquadro nello spazio di lavoro. 

3. Immettere il testo. È possibile definire lo stile del testo utilizzando la finestra di dialogo Testo. 

  

Per aprire la finestra di dialogo Testo:  

Scegliere Oggetto >Testo. 

- oppure - 

Premere il tasto F7. 

Creazione di un oggetto codice a barre 

Il software offre un'ampia gamma di simboli adatti alle esigenze del settore, nonché la possibilità di creare 

codici a barre a 2D. 

La selezione dei simboli, la definizione dei rispettivi attributi e l'immissione del messaggio da codificare 

avvengono tramite la finestra di dialogo Barcode. 

Per creare un oggetto codice a barre: 

1. Nella barra degli strumenti Creazione, fare clic sullo strumento Crea codice a barre . 

- oppure - 

Scegliere Oggetto > Codice a barre 

  

2. Fare clic all'interno dello spazio di lavoro.  

Si apre la finestra di dialogo Codice a barre.  

  

 



Composizione di un documento con oggetti fissi 

3. Dalla scheda Codice, selezionare il codice a barre desiderato. È possibile scegliere fra Stampante e 

Grafica. 

  

4. Fare clic su Stampante per visualizzare l'elenco dei codici a barre disponibili nella stampante. 

- oppure - 

fare clic su Grafica per visualizzare l'elenco dei codici a barre generati dal software. 

5. Se necessario, specificare le caratteristiche del codice a barre (altezza, larghezza barra stretta, 

rapporto, carattere di controllo). 

  

6. Immettere i dati da codificare nella finestra Dati. 

  

7. Fare clic su OK. 

Nota : Alcune stampanti non dispongono di codici a barre. Ciononostante è possibile stampare codici a barre 

tramite l'opzione Grafica. In questo modo però il funzionamento della stampante è molto rallentato in quanto i 

codici a barre vengono inviati alla stampante sotto forma di immagini grafiche. 

Creazione di un oggetto forma Esempio: tracciare una linea 

Il software viene fornito con una gamma di strumenti che consentono all'utente di creare etichette perfette. 

È possibile disegnare una linea, un cerchio, un rettangolo e così via utilizzando il processo descritto in seguito. 

Per tracciare una linea: 

1. Fare clic sullo strumento Disegna linea . 

- oppure - 

Scegliere Oggetto > Disegno >Linea. 

2. Fare clic all'interno dello spazio di lavoro. 

3. Muovere il mouse tenendo premuto il pulsante sinistro. 

Esempio: Creazione di una custodia per CD: disegno di un cerchio 

 

1. Fare clic sullo strumento di disegno cerchio o ellisse. 

2. Fare clic all'interno dello spazio di lavoro. 

3. Tenendo premuto il pulsante sinistro del mouse e contemporaneamente il tasto MAIUSC, muovere il mouse 

orizzontalmente per creare la forma desiderata. 

4. Selezionare il cerchio e scegliere Proprietà dal menu di scelta rapida. 

5. Fare clic sulla scheda Posizione e immettere i seguenti valori:  

  Larghezza e Altezza: 20.  

6. Fare clic su OK. 

7. Selezionare Oggetto > Allineamento > Orizzontale al centro dell' etichetta per allineare il cerchio al 

centro della custodia. 

8. Selezionare il cerchio e fare clic sul pulsante Blocca. 
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Importazione di un'immagine 

Il software consente di inserire immagini e loghi aziendali per perfezionare le etichette. 

È possibile importare diversi formati: bmp, dib, dxf, emf, fmf, eps, fpx, img, gif, jpg, pcd, pcx, dcx, png, rle, 

tga, tif, wmf e wpg. 

1. Dalla barra degli strumenti di Creazione, fare clic sullo strumento Importa immagine  

- oppure - 

Scegliere  Oggetto > Immagine. 

2. Fare clic all'interno dello spazio di lavoro. 

Si apre la finestra di dialogo Selezione immagine. 

3. Nella scheda Trova file, selezionare l'immagine da importare.  

4. Selezionare il nome del file dell'immagine. 

5. Fare clic su OK. 

Nota : Per visualizzare un'anteprima dell'immagine, fare clic sul pulsante Anteprima. 
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Informazioni sulle origini dati 

Un'origine dati contiene un elenco di variabili costituite da dati che hanno la stessa origine. 

Quando si seleziona una origine dati, si indica dove risiedono i dati richiesti e di che tipo sono. I dati possono 

avere origine interna (formula, data, contatore) o esterna all'applicazione (database, immissione diretta, 

ActiveX). 

Le varie origini dati disponibili nella vista o nel menu Origini dati sono le seguenti: 

 L'origine dati Database: consente di connettersi a un database. 

 L'origine dati Data: consente di inserire data e ora. 

 L'origine dati Formula: consente di creare formule all'interno del documento. 

 L'origine dati Modulo: consente l'immissione di dati durante la stampa. 

 L'origine dati Ricerca in tabella: consente di aggiungere il risultato delle ricerche effettuate nei 

database. 

 L'origine dati Contatore: consente di inserire un valore auto-incrementante. 

 L'origine dati Libera: origine dati popolata da dati che non sono stati specificati al momento della 

creazione. Un'origine dati libera può essere utilizzata per creare origini dati intermedie. 

Creazione di una origine dati 

Le origini dati consentono di utilizzare dati esterni all'applicazione, ad esempio dati di calcolo, la data di sistema 

del computer e così via. I valori associati a tali variabili provengono da diverse origini dati.  

È possibile creare una origine dati da: 

La vista Origini dati 

1. Nella vista Origini dati, fate clic con il pulsante destro su una delle sorgenti di dati. 

2. Selezionate Aggiungi dal menu pop-up. 

Il menu Origini dati 

1. Fare clic sul menu Origini dati.  

2. Selezionare una delle sorgenti dati. 

3. Fare clic su Aggiungi. 

La barra degli strumenti 

1. Fare clic su  nella barra degli strumenti. 

2. Selezionare la origini dati desiderata. 

3. Nel sottomenu, selezionare Aggiungi. 
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Per ognuna di queste modalità di creazione: 

 L'origine dati creata viene visualizzata automaticamente nella origine dati selezionata. 

 L'applicazione associa all'origine dati un nome predefinito.  

Nota: Non è possibile utilizzare parentesi {} nel nome della variabile.  

Nota: Questa procedura si applica a tutte le origini dati, ad eccezione delle variabili create nell'origine dati 

Database. Per creare una variabile database, è necessario creare una query.  

L'origine dati Database 

Comando: Origine dati > Database > Crea/Modifica una query. 

L'origine dati Database contiene un elenco di variabili create in base alle necessità. Tali variabili sono popolate 

da dati provenienti da query o tabelle ASCII. 

Nota : Quando vengono create, le origini dati conservano i nomi dei campi che le popolano. 

Nota: Non è possibile rinominare le variabili database in quanto sono associate ai nomi dei campi del database. 

Creazione di una query 

1. Selezionare l’origine dati dall’elenco Seleziona una origine dati. 

Nota: Per selezionare una nuova origine dati, fare clic sul pulsante New data source. In questo modo sarà 

possibile utilizzare la procedura guidata oppure scegliere tra una origine dati ODBC o OLEDB. 

2. Come impostazione predefinita, è attivata la modalità di creazione Standard. Tuttavia, per creare la 

 query, è possibile utilizzare la modalità di creazione Avanzata SQL: 

Modalità di creazione standard 

3. Nell'elenco Seleziona una tabella, selezionate la tabella in cui effettuare la ricerca.  

L’opzione Inserisci il nome delle tabelle consente di visualizzare i nomi delle tabelle nell’elenco dei 

campi.  

4. Nell’elenco Elementi, selezionate gli elementi che desiderate visualizzare.  

5. Nell’elenco Seleziona campi, selezionate i campi delle tabelle selezionate. 

Suggerimento È consigliabile selezionare unicamente i campi utilizzati nell'etichetta, questo per ridurre gli 

scambi di dati con il database e quindi aumentare la velocità di elaborazione. 

6. Fate clic sul pulsante  per visualizzare il risultato. 

Modalità di creazione avanzata SQL  

3. Selezionate la modalità SQL. 

4. Immettete la query in formato SQL nel campo di modifica. 

-oppure-  
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Fate clic su SQL Query Builder per accedere a Creazione query. Utilizzate l’intuitiva interfaccia per 

creare le query del database SQL. Potete creare nuove richieste graficamente oppure rappresentare 

graficamente richieste esistenti nelle vostre applicazioni. 

5. Fare clic su  per vedere il risultato. 

Le origini dati create hanno i nomi dei campi del database.  

L'origine dati Ricerca in tabella 

Comando Origine dati > Ricerca in tabella > Aggiungi 

L'origine dati Ricerca in tabella contiene un elenco di origini dati che sono state create dall'utente. I valori 

dell'origine dati sono il risultato di ricerche condotte all'interno di database diversi da quelli associati al 

documento corrente. 

Tali ricerche vengono condotte in uno o più campi di database. I dati vengono estratti da uno dei campi 

individuati in un record (chiamato "campo risultato"). 

Definizione delle proprietà dell'origine dati Ricerca in tabella 

1. Selezionare l’origine dati dall’elenco  Seleziona una origine dati. 

Nota: Per creare una nuova origine dati, fare clic sul pulsante Nuova... In questo modo sarà possibile utilizzare 

la procedura guidata oppure scegliere tra una origine dati ODBC o OLEDB. 

2. Come impostazione predefinita, è attivata la modalità di creazione standard. Per effettuare una  

ricerca in tabella, è possibile anche utilizzare la modalità di creazione Avanzata: SQL 

Modalità di creazione standard  

3. Nell'elenco Seleziona una tabella, selezionate la tabella in cui effettuare la ricerca. 

4. Nell’elenco Seleziona il campo risultato, selezionate il campo il cui valore dovrà essere trasferito 

nella vostra variabile. 

5. Fare clic su  per aggiungere una riga. 

6. Selezionare il campo nella tabella esterna in cui volete eseguire la ricerca. 

7. Selezionare la variabile del documento corrente contenente il valore della ricerca. 

8. Fare clic sul pulsante Prove per visualizzare il risultato. 

Modalità di creazione avanzata SQL  

3. Fare clic sulla modalità di creazione del formato SQL. 

4. Inserire la query in formato SQL.  

-oppure-  

Fare clic su SQL Query Builder per accedere a Creazione query. In questo modo potrete avvalervi di 

un’intuitiva interfaccia per creare le query del database SQL. Potete creare nuove richieste 

graficamente oppure rappresentare graficamente richieste esistenti nelle vostre applicazioni.  

5. Fare clic sul pulsante Prove per visualizzare il risultato. 
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L'origine dati Data 

Comando Origine dati > Data > Aggiungi 

L'origine dati Data contiene un elenco di origini dati che sono state create. Tali origini dati vengono popolate 

dalla data di sistema del computer o dalla stampante. Questa origine dati consente di visualizzare la data e 

l'orario in un formato definito precedentemente. I valori vengono popolati automaticamente all'avvio di ogni 

sessione di stampa. 

È possibile inserire la data e/o l'ora corrente in un documento. È inoltre possibile aggiungere un valore fisso alla 

data o all'ora corrente. 

Definizione delle proprietà dell'origine dati Data 

1. Nella scheda Data, selezionare il formato desiderato per la data e l'ora. 

2. Il formato della data viene visualizzato nell'area Anteprima. 

3. Fare clic su OK. 

Esempio: Inserimento di una data 

 

1. Aprire  una etichetta. 

2. Aggiungere una origine dati Data e denominarla datefab. 

3. Comporre la data nella finestra di dialogo Data. È necessario che il formato sia gg/mm/aa. Per aggiungere 

dei separatori, immettere il carattere "/" nella casella di testo nella parte in basso a sinistra della finestra di 

dialogo, quindi fare clic su Aggiunti. 

4. Fare clic su OK. 

5. Selezionare la data (datefab) e trascinarla nello spazio di lavoro. 

6. Scegliere Testo nel menu di scelta rapida. 

L'origine dati Contatore 

Comando Origine dati > Contatore > Aggiungi 

L'origine dati Contatore contiene un elenco di origini dati che sono state create dall'utente. Tali origini dati 

vengono popolate da dati calcolati dal computer o dalla stampante. 

Il contenuto cambia con l'avanzare della stampa, in base a un valore iniziale e a un valore incrementale. 

Definizione delle proprietà dell'origine dati Contatore 

1. Selezionare il tipo di contatore. 

Se si desidera utilizzare un tipo di contatore diverso da quelli visualizzati nell'elenco, scegliere l'opzione 

Personalizzato e immettere una sequenza personalizzata. 

2. Immettere un valore nella casella Incremento. Per impostazione predefinita, l'incremento è uguale a 

+1. 

3. Immettere un valore iniziale nella casella Valore iniziale. Per impostazione predefinita, tale valore è 

uguale a 0. 

4. Fare clic su OK. 
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L'origine dati Formula 

Comando Origine dati > Formula > Aggiungi 

L'origine dati Formula contiene un elenco di origini dati che sono state create dall'utente. Tali origini dati 

vengono popolate da combinazioni di operatori, costanti, variabili, variabili di controllo, formule e funzioni. I dati 

possono essere numerici o alfanumerici. 

Per effettuare un calcolo all'interno di un documento, è necessario creare una origine dati Formula. 

Per questa origine dati esiste una finestra di dialogo specifica che consente di definire le funzioni necessarie alla 

formula data. 

Definizione delle proprietà dell'origine dati Formula 

1. Immettere la formula direttamente nella casella editing. 

-o- 

Selezionate con il mouse gli elementi desiderati quindi fate clic su Inserisci. 

2. Fare clic su OK. 

Suggerimento: È possibile inserire un elemento selezionandolo con un doppio clic. 

Nota: Se il nome di una variabile utilizzata nella formula contiene uno dei seguenti caratteri &+-*/<>=^%,!\", 

deve essere racchiusa tra parentesi {}. 

Note : È possibile verificare la formula facendo clic su Prova. Se nel messaggio viene visualizzato il valore 

della formula significa che questa è corretta. Se il valore non è corretto, seguire le istruzioni visualizzate a video 

e apportare le necessarie modifiche. Se il valore ottenuto è troncato, è necessario modificare la lunghezza 

massima specificata nella scheda Output. 

 

Esempio: Creazione di una formula semplice 

Visualizzazione del prezzo di un prodotto 

 

L'etichetta di produzione deve indicare il prezzo del prodotto come funzione del peso e del prezzo al 

chilogrammo. 

 

1. Aprire una etichetta con due variabili: WEIGHT e PRICEPERKG. 

 

Per la variabile WEIGHT: immettere 788 (assumendo che il peso del prodotto sia 788 g) come valore Local e 

immettere "Immettere il peso in g" nella casella Prefix, quindi fare clic su OK. 

 

Per la variabile PRICEPERKG: immettere 15,70 (il peso al kg è 15,70 euro) come valore Local della variabile e 

immettere "Immettere il prezzo al kg" nella casella Prefix, quindi fare clic su OK. 

 

2. Aggiungere una formula e denominarla Prezzo. 
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3. Immettere la formula WEIGHT*PRICEPERKG/1000, quindi fare clic su OK. 

 

4. Salvare il documento. 

 

Esempio: Aggiunta di una variabile della formula "Avviso" per la visualizzazione di un messaggio di 

avviso. 

 

Nella sequenza seguente, verrà creata una formula nell'etichetta PRODUCT_WS3.LAB perché venga visualizzato 

un messaggio di avviso che segnali all'utente che il valore della variabile condivisa Total_Weight supera 1.000 

kg. 

 

Se il valore del peso supera i 1.000 kg, viene visualizzato il messaggio "Attenzione! Errore! Il peso totale supera 

il massimo consentito!" 

 

1. Aprire l'etichetta. 

 

2. Creare una formula e denominarla "Avviso". 

 

3. Nella casella di dialogo Formula, immettere la seguente espressione:  

if(Total_Weight>1000, "Attenzione\n!Errore!\n Il peso totale supera il massimo consentito!", ""). 

 

4. Nella scheda Output, immettere 50 in Maximum length e fare clic su OK. 

 

5. Posizionare la variabile come testo all'interno dell'etichetta. 

 

6. Nella casella di dialogo Testo, selezionare Scalable come font e impostare il valore di Height a 12,70 mm. 

 

7. Nella scheda Paragrafo, selezionare l'opzione A capo automatico e quindi Centra (allineamento) 

Informazioni sulla funzione IF 

Restituisce un valore se la condizione specificata è TRUE, un altro se è FALSE. 

La funzione IF viene utilizzata per effettuare test condizionali su valori e formule. 

La sintassi 

if("expr","val_if_true","val_if_false”) ”expr" rappresenta qualsiasi valore o espressione il cui risultato può 

essere TRUE o FALSE. 

val_if_true è il valore restituito se "expr" è TRUE. L'argomento val_if_true può essere un'altra formula. 

val_if_false è il valore restituito se "expr" è FALSE. L'argomento val_if_false può essere un'altra formula. 
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L'origine dati Modulo 

Comando Origine dati > Modulo > Aggiungi 

L'origine dati Modulo contiene un elenco di variabili che sono state create dall'utente. Tali variabili vengono 

popolate immettendo dati direttamente dal Modulo digitando sulla tastiera. 

Per visualizzare il modulo 

Il Modulo consente di immettere i dati direttamente durante la progettazione o, più comunemente, prima della 

stampa. 

1. Aprire l'etichetta contenente una variabile Modulo. 

2. Fare clic sul pulsante    nella barra degli strumenti. 

Come impostazione predefinita, lo spazio di lavoro consente di visualizzare l'etichetta e il modulo 

separatamente. 

Per visualizzare l'etichetta e il modulo insieme: 

1. Selezionare l'etichetta relativa al modulo. 

2. Trascinare il tutto sulla destra dello spazio di lavoro. Ora è possibile visualizzare entrambi gli elementi.  

Tutte le modifiche apportate all'etichetta o al modulo aggiorneranno automaticamente i dati dell'altro. 

 

Personalizzazione del Modulo  

È possibile personalizzare l'aspetto del modulo modificando il colore, il font, ecc. nella finestra di dialogo 

Personalizzazione del modulo. 

Per accedere alla finestra di dialogo modulo 

1. Aprite l'etichetta contenente una variabile modulo. 

2. Fate clic sul pulsante   nella barra degli strumenti. 

Come impostazione predefinita, lo spazio di lavoro consente di visualizzare l'etichetta e il modulo 

separatamente. 

Per visualizzare l'etichetta e il modulo insieme: 

1. Selezionate l'etichetta relativa al modulo. 

2. Spostate tutto a destra dello spazio di lavoro tenendo premuto il pulsante sinistro del mouse.  Ora è 

possibile visualizzare entrambi gli elementi.  

 

Tutte le modifiche apportate all'etichetta o al modulo aggiorneranno contemporaneamente i dati 

dell'altro. 
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Modifica dell'ordine dei dati immessi nel modulo 

È possibile modificare l'ordine in cui i dati vengono immessi nel modulo. 

Procedere come segue: 

1. Selezionare il modulo utilizzando il mouse. 

2. Fare clic con il pulsante destro. 

3. Selezionare Start tab ordering. Viene visualizzata la numerazione predefinita. 

4. Fare clic sul numero del campo che si desidera venga visualizzato per primo nel modulo.  Il numero 

diventa verde quando viene convalidato. 

5. Ripetete il passaggio 4 per continuare a ordinare i campi. 

6. Per confermare la selezione, fare clic sul pulsante destro e selezionare Validate tab ordering.  L'ordine 

dei campi verrà convalidato automaticamente alla convalida del primo campo.  Quindi la numerazione 

scompare dal modulo. 

Nota: È inoltre possibile annullare qualsiasi modifica. Fare clic con il pulsante destro del mouse sul modulo e 

selezionare Abort tab ordering. 

Definizione delle proprietà dell'origine dati Modulo 

1. Fare clic sulla scheda Modulo. 

2. Immettere il messaggio che si desidera venga visualizzato nel modulo. 

3. Se lo si desidera, è possibile definire un formato di immissione e una lunghezza minima. 

4. È possibile creare valori che verranno proposti nel modulo selezionando <Locale> dalla Elenco 

valori. In seguito fare clic su per accedere alla finestra di dialogo Elenco valori. 

5. Nella scheda Output, è possibile definire un formato di output, una lunghezza massima, un suffisso e 

un prefisso. 

6. Fare clic su  OK. 

Nota : Se viene definito un valore locale vuoto e si seleziona la casella Ripristina dopo la stampa, il valore 

della variabile verrà impostato su vuoto dopo ogni lavoro di stampa. 

L'origine dati Libera 

Comando Origine dati > Libera > Aggiungi 

L'origine dati Libera contiene un elenco di origini dati che sono state create dall'utente. Queste origini dati sono 

popolate da dati che non sono stati specificati al momento della creazione. Un'origine dati Libera può essere 

utilizzata per creare origini dati intermedie. 
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Definizione delle proprietà dell'origine dati Libera 

Definite le proprietà delle origine dati dalla vista Origini dati. 

1. Nella scheda Input,selezionare una delle seguenti opzioni:Locale o Condivisa o A partire da un file. 

Se è stata scelta l'opzione Local, immettere il valore della variabile nella casella. Questo sarà il valore 

iniziale della variabile, quello che verrà stampato per primo. 

- oppure - 

Se è stata scelta l'opzione Condivisa, immettere il valore della variabile nella casella. Fare clic su OK. 

- oppure - 

Se è stata scelta l'opzione A partire da un file, selezionare il file richiesto. 

2. Nella scheda Output, è possibile definire un formato di output, una lunghezza massima, un suffisso e 

un prefisso. 

3. Fare clic su OK. 

Esempio: Creazione di una variabile libera 

 

1. Aprire una etichetta. 

2. Creare una origine dati Libera e denominarla ''ref''. 

3. Inserire l'origine dati nell'etichetta in formato testo. 

4. Per evitare che l'origine dati venga visualizzata nella stampa, selezionarla e fare clic su  nella barra degli 

strumenti Oggeto. 

Creazione di oggetti variabili 

Il concetto di oggetto fisso è legato a quello di oggetto variabile. 

Un oggetto variabile è un testo, un codice a barre o un oggetto di tipo immagine costituito da elementi i cui 

valori non sono stati definiti al momento della creazione. È possibile associare diversi oggetti a una singola 

variabile. 

Il valore di tali elementi viene derivato da diverse origini dati al momento della stampa: 

 Immissione diretta dalla tastiera nel Modulo (origine dati Modulo). 

 Importazione da file o database esterno (origine dati Ricerca in tabella o Database ) 

 Calcolo del campo da computer (origini dati Formula, Contatore e Data) 

Nota :Nella vista Origini dati, una freccia rossa   indica la variabile associata all'oggetto selezionato.. 

Creazione di un oggetto variabile collegato a una origine dati esistente 

Creazione di oggetti variabili 

È possibile creare in modo semplice e veloce un oggetto variabile (codice a barre, immagine, testo, disegni 

ecc.) nel documento utilizzando: 

 La barra degli strumenti di Creazione, 
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-oppure- 

 Il menu Oggetto. 

Seguendo le indicazioni fornite, è possibile creare un oggetto utilizzando una delle seguenti opzioni: 

 Creazione modalità diretta: 

1. Fare clic direttamente sull'oggetto che si desidera inserire nel documento. 

2. Fare clic sul punto in cui si desidera posizionare l'etichetta. 

La creazione guidata si avvia come impostazione predefinita. In caso contrario, fare doppio clic 

sull'oggetto per aprire la finestra di dialogo Proprietà. 

3. Fare clic sulla scheda Origini dati. 

4. Selezionare Variabili. 

5. Selezionare la variabile che si desidera assegnare all'oggetto. 

- oppure - 

 Creazione modalità guidata (secondo i requisiti di utilizzo): 

1. Fare clic sul pulsante del menu dell'oggetto. Viene visualizzato un sottomenu che mostra le azioni 

disponibili 

2. Per creare un oggetto variabile utilizzando una origine dati esistente, si può scegliere di: 

- Selezionare Utilizzo di una origine dati esistente seguito dalla variabile interessata. 

oppure 

- Selezionare Procedura guidataper essere guidati passo per passo nel processo di creazione 

dell'oggetto variabile. 

3. Fare clic sul punto in cui si desidera posizionare l'etichetta. 

Nota: la creazione guidata è abilitata come impostazione predefinita. Per disabilitarla, selezionare Strumenti > 

Opzioni > Procedure guidate. 

Creazione di un oggetto variabile collegato a una nuova origine dati 

Creazione di oggetti variabili 

È possibile creare in modo semplice e veloce un oggetto variabile (codice a barre, immagine, testo, disegni 

ecc.) nel documento utilizzando: 

 La barra degli strumenti di Creazione, 

-oppure- 

 Il menu Oggetto. 

Seguendo le indicazioni fornite, è possibile creare un oggetto utilizzando una delle seguenti opzioni: 

 Creazione modalità diretta: 
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1. Fare clic direttamente sull'oggetto che si desidera inserire nel documento. 

2. Fare clic sul punto in cui si desidera posizionare l'etichetta. 

La creazione guidata si avvia come impostazione predefinita. In caso contrario, fare doppio clic 

sull'oggetto per aprire la finestra di dialogo  Proprietà. 

3. Fare clic sulla scheda Origini dati. 

4. Selezionare Variabili. 

5. Selezionare la variabile che si desidera assegnare all'oggetto, fare clic con il pulsante destro del mouse 

e selezionare Aggiungere. 

-oppure- 

Fare clic sul pulsante Nuovo, quindi selezionate la variabile da aggiungere. 

 -OPPURE- 

 Creazione modalità guidata (secondo i requisiti di utilizzo): 

1. Fare clic sul pulsante del menu dell'oggetto. Viene visualizzato un sottomenu che mostra le azioni 

disponibili. 

2. Per creare un oggetto variabile utilizzando una nuova variabile, è possibile scegliere di: 

- Selezionare Nuova origine dati, 

oppure 

- Selezionare Procedura guidata: per essere guidati passo per passo nel processo di creazione 

dell'oggetto variabile. 

3. Fare clic sull'ubicazione in cui desiderate posizionare l'etichetta. 

Nota: la creazione guidata è abilitata come impostazione predefinita. Per disabilitarla, selezionare Strumenti > 

Opzioni > Procedure guidate. 
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Stampa 

Un potente motore di stampa  

Il software è uno strumento di creazione potente e semplice da usare e al contempo un motore di stampa 

utilizzabile con la più vasta gamma di stampanti possibile (termiche, a trasferimento termico, a getto 

d'inchiostro), mai disponibile finora sul mercato dell'identificazione automatica. 

Per qualsiasi lavoro di stampa, una singola etichetta, una serie di etichette o svariate copie della stessa 

etichetta, i comandi di stampa sono raggruppati in un unico punto, la finestra di dialogo Stampa. 

Inoltre, il software per l'etichettatura consente di installare e controllare le stampanti in qualsiasi punto della 

rete. 

In questa sezione verranno illustrate tutte le possibili configurazioni di rete e le relative procedure di 

installazione per l'ottimizzazione della stampa delle etichette.  

Stampa di un documento 

Per qualsiasi lavoro di stampa, una singola etichetta, una serie di etichette o svariate copie della stessa 

etichetta, le impostazioni di stampa vengono definite tutte nella la finestra di dialogo Stampa. 

1. Scegliere File > Stampa per accedere alla finestra di dialogo Stampa. 

È anche possibile fare clic sul pulsante  o premere F6. 

2. Nella casella di testo Etichette, immettere il numero di etichette da stampare. 

3. Fare clic su OK. 

Esercitazione pratica 1 - Etichetta e serie di etichette 

Per iniziare, è necessario chiarire la distinzione fra Etichetta e serie di etichette. 

Nota: Se l'etichetta non include un contatore, la finestra di dialogo Stampa non visualizzerà il campo Copies of 

each label, ma solo il campo Labels, che in questo caso avrà la stessa funzione. 

Per chiarire la differenza fra Etichetta e serie di etichette, verrà presa in considerazione un'etichetta 

contenente due tipi di contatori e la finestra di dialogo Stampa verrà configurata in diversi modi. 

 Aprire una etichetta . 

Creare diversi contatori: 

 Un contatore classico che conta tutte le etichette e si reimposta quando il conteggio raggiunge 

10: 

 Tipo 

 Incremento +1 

 Valore minimo 0 

 Valore massimo 10 
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• Un contatore ISO che consente la numerazione singola di ciascuna copia delle etichette. Anche questo 

contatore si reimposta quando raggiunge il valore 10: 

 Tipo 

 Incremento +1 

 Valore minimo 0 

Il primo contatore, chiamato NumLabel, identifica un'etichetta particolare mentre il contatore ISO conta il 

numero totale di etichette stampate. 

Etichette in serie 

In questo esempio verrà stampata una serie di 10 etichette: 

1. Specificare i seguenti valori nella finestra di dialogo Stampa: 

 Etichette : 10. 

In questo modo viene specificato che nella serie saranno presenti 10 diverse etichette. 

2. Fare clic su Stampa. 

Il risultato della stampa è quello atteso: sono state stampate 10 etichette e i due contatori visualizzano lo 

stesso valore. 

Copia delle etichette 

In questo esempio verrà stampata una serie di cinque etichette, questa volta però verranno realizzate due copie 

per ognuna. 

1. Specificare i seguenti valori nella finestra di dialogo Stampa: 

 Etichette: 5 

 Copia delle etichette: 2. 

2. Fare clic su Stampa. 

Sono state stampate 10 etichette; tuttavia, il risultato è completamente diverso rispetto a quanto ottenuto 

nell'esempio precedente. 

Copia di una pagina 

Come abbiamo appena visto, è possibile stampare diverse copie della stessa etichetta. Nel prossimo esempio 

vedremo che è possibile anche stampare diverse copie della stessa pagina. Per far ciò, è necessario sapere con 

esattezza che cos'è una pagina per la stampante. 

La pagina è determinata dai parametri specificati durante la configurazione del driver della stampante. I risultati 

ottenuti possono essere completamente diversi a seconda che si utilizzi una stampante da ufficio o una 

stampante termica. Può essere difficile visualizzare una pagina su carta continua, utilizzata principalmente dalle 

stampanti termiche. 

Inoltre, in base alle dimensioni del supporto di stampa e dell'etichetta, le dimensioni della pagina possono 

corrispondere a quelle dell'etichetta, di conseguenza la copia della pagina può essere la stessa dell'etichetta. 

 



Stampa 

Il formato della pagina e la dimensione dell'etichetta vengono definiti nella finestra di dialogo Imposta pagina. 

1. Aprire  una etichetta. 

2. Selezionare File > Seleziona stampante. 

3. Selezionare una stampante per ufficio Windows. 

4. MVerificare che il formato della carta sia A4, quindi fare clic su OK. 

5. Selezionare File > Imposta pagina o fare clic su  . 

Verrà visualizzata la finestra di dialogo Imposta pagina. 

L'anteprima di stampa dà un'idea di come sarà la pagina stampata. 

6. Chiudere la finestra di dialogo. 

7. Fare clic su  . 

8. Immettere i seguenti valori: 

 Etichette: 8 

 Copie per pagina: 2 

9. Fare clic su Stampa. 

Esercitazione pratica 2 - Unione di stampa 

L'unione di stampa è disponibile solo se l'etichetta è associata a un database (ASCII or ODBC). 

La funzione di unione stampa tutti i record contenuti nel database. 

Avvio di una unione di stampa 

L'opzione di unione è disponibile quando è stato aperto un database di tipo merge. Avvia la stampa delle 

etichette, con l'inclusione di tutti i record del database. 

1. Scegliere File > Stampa per accedere alla finestra di dialogo Stampa. 

-oppure- 

Fare clic sul pulsante . 

2. Nella casella di testo Etichette, immettere il numero di etichette da stampare.  

3. Nel campo Record, selezionatre Tutti i record 

4. Fare clic su OK. 

Esercitazione pratica 3 - Stampa con il modulo 

Molto spesso i dati delle variabili devono essere immessi manualmente da un operatore subito prima della 

stampa. L'applicazione offre un metodo di inserimento dati rapido e semplice: il Modulo. 

Stampa con il modulo 

1. Selezionare File > Stampa oppure premere il tasto F6. 
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2. Immettere ''2'' nel campo Etichette.  

3. Avviare la stampa. 

Il modulo viene visualizzato ed è necessario immettere i dati da stampare. 

4. Immettere ''Smith'' e ''51'',  ad esempio, quindi fare clic su OK. 

Una volta stampata la prima etichetta, il modulo viene visualizzato nuovamente. 

5. Immettere ''Mullang'' e ''52'', ad esempio, quindi fare clic su OK. 

Note: Il modulo viene visualizzato per ogni etichetta contenuta nella serie. Se si sceglie l'opzione Per ogni 

serie, il modulo verrà visualizzato una sola volta, all'avvio della stampa della serie. 

In breve 

La finestra di dialogo Print 

contiene differenze... 

Quando l'etichetta include un contatore: l'opzione Etichette consente di 

specificare il numero di etichette in una serie;  

Copia delle etichette consente di determinare il numero di copie della 

stessa etichetta da stampare. 

Quando l'etichetta non include un contatore, questa opzione ha la stessa 

funzione del campo Etichette. 

Copia di una pagina È possibile copiare una pagina solo se l'etichetta non include un 

contatore ISO e se la pagina contiene più di un'etichetta. 

Unione di stampa Questa opzione stampa tutti i record in un database ed è disponibile solo 

se l'etichetta è associata a un database. 

Stampa con il Modulo Il Modulo consente all'operatore di immettere i dati dalla tastiera subito 

prima della stampa. 

Ottimizzazione della stampa 

Sempre più stampanti sono fornite di porte parallele, USB o TCPIP, che noi consigliamo vivamente di utilizzare, 

invece delle porte seriali. Se si desidera stampare immagini bitmap, grafica o font Windows TrueType, l'utilizzo 

della porta parallela consentirà la massima ottimizzazione delle prestazioni del sistema in termini di capacità di 

trasferimento dati. Inoltre, esiste un solo tipo di cavo per tutti i tipi di collegamento parallelo, mentre non esiste 

uno standard per i cavi seriali. In questo modo, si evitano problemi con i requisiti per i cavi della stampante. 

Detto questo, dal momento che molte stampanti hanno ancora in dotazione solo il collegamento seriale, in 

questa sezione analizzeremo i problemi che si possono incontrare con le comunicazioni seriali e illustreremo 

come configurare Windows perché comunichi senza inconvenienti con la stampante. 

Inoltre, è importare ricordare che i driver della stampante di Windows e il programma che si utilizza per la 

stampa non controllano le comunicazioni seriali tra il computer e la stampante. La modalità di comunicazione 

viene determinata dai seguenti elementi: 

 Le impostazioni della stampante 

 Il tipo di cavo seriale utilizzato 

 Le impostazioni di comunicazione seriale utilizzate nel pannello di controllo di Windows. 
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Ottimizzazione della velocità di stampa 

Come abbiamo visto nell'introduzione, non esiste una configurazione universale in grado di ottimizzare la 

velocità di stampa, ma è possibile configurare una serie di diverse impostazioni. Nell'esempio che segue 

verranno analizzate tutte una per una, in modo da fornire un quadro chiaro della configurazione di sistema che 

consenta di individuare le impostazioni migliori per ottimizzare la stampa. 

Sono quattro i principi base da tenere presenti per migliorare la velocità della stampa: 

 Utilizzare la porta parallela ogniqualvolta sia possibile. 

 Utilizzare gli oggetti di stampa (font, codici a barre ecc.) ogniqualvolta sia possibile. 

 Nel caso di un collegamento seriale, se la stampante dispone dell'opzione, utilizzare Windows Font 

Downloader. Questo strumento plug-in consente di scaricare qualsiasi font di Windows nella memoria 

della stampante in modo facile e veloce, integrandolo così nelle risorse della stampante. Per maggiori 

informazioni sul plug-in (fornito con l'applicazione), fare riferimento alla documentazione disponibile 

nel CD-ROM dell'applicazione. 

 Utilizzare il comando Send modified data only, disponibile nella maggior parte delle stampanti e nella 

finestra di dialogo Configura la stampante. 

L'opzione Accesso diretto è disponibile quando viene configurato il driver della stampante e quando viene 

selezionata la porta. La tabella riportata di seguito illustra quando è possibile utilizzare questa opzione: 

Porta Accesso diretto Accesso indiretto 

Seriale Sì Sì 

Parallela Sì Sì 

Rete No Sì 

L'utilizzo di questa opzione dipende dalle singole esigenze: 

 Nell'accesso diretto, il driver comunica direttamente con la stampante. L'utente non ha alcun controllo 

sugli eventi finché la stampa non è completata (il che può implicare un certo ritardo). 

 Senza l'opzione di accesso diretto, il driver trasferisce i dati a una coda di stampa che gestisce la 

comunicazione. L'utente riacquista il controllo una volta che tutti i dati sono stati trasferiti alla gestione 

della stampa (con un ritardo nettamente inferiore). 

Collegamento parallelo e comunicazione seriale 

Visti i numerosi vantaggi derivanti dall'utilizzo delle immagini, come l'ampia gamma di immagini grafiche 

Windows, l'utilizzo di una stampante con porta parallela consentirà di ottenere risultati decisamente migliori. La 

maggior parte delle stampanti termiche standard hanno solo il collegamento seriale (RS 232), mentre la porta 

parallela è una funzionalità opzionale. 

La comunicazione seriale funziona correttamente finché si stampano solo oggetti della stampante (codici a 

barre, font ecc.). Nel momento in cui si desidera stampare immagini bitmap, la velocità di stampa si riduce 

notevolmente. 

Nota: Per stampare immagini, utilizzare il collegamento parallelo ogniqualvolta sia possibile. 
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Guida per l'utente 

Stampa di immagini 

Gli oggetti non stampante, ad esempio un logo aziendale, devono essere trasferiti alla stampante. 

All'aumentare delle immagini inviate alla stampante la velocità di stampa si riduce, soprattutto se si utilizza una 

connessione seriale. La soluzione è inviare l'immagine desiderata una sola volta, quando si avvia per la prima 

volta la stampa di una serie di etichette. 

Questa operazione è consentita dalla maggior parte delle stampanti. 

Quando si utilizza l'opzione Send modified data only, l'immagine viene inviata alla stampante una sola volta, 

all'avvio della stampa, operazione che può richiedere un po' di tempo. Tuttavia, una volta che la prima etichetta 

è stata stampata, il processo di trasferimento dei dati diventa più rapido e le prestazioni di stampa della serie di 

etichette migliorano. 

Note: The label background is stored in the printer’s memory. As a result, the fixed image does not need to be 

transferred via the cable once the first label is printed. 

Nota: Lo sfondo dell'etichetta viene salvato nella memoria della stampante. Di conseguenza, non è necessario 

trasferire l'immagine fissa tramite il cavo una volta che la prima etichetta è stata stampata. 

La sostituzione dei font TrueType viene utilizzata al momento della stampa per modificare in modo dinamico un 

font TrueType in un font della stampante. Lo scopo di questa funzionalità è consentire all'utente di creare una 

singola etichetta che può essere stampata con diversi tipi di stampante. Utilizzando l'opzione di sostituzione dei 

font TrueType, lo stesso font TrueType, nel momento della stampa, verrà ridefinito con il miglior font della 

stampante possibile al fine di ottimizzare la velocità di stampa. 

Risoluzione dei problemi 

La seguente tabella elenca i problemi che si verificano più di frequente durante la stampa e offre alcune 

soluzioni per aiutare l'utente a risolverli. 

Problema Causa Soluzione 

Non viene stampato 

niente 

La stampante non è collegata. Collegare la stampante. 

 Per un collegamento parallelo: 

- La stampante non è configurata 

per un collegamento parallelo. 

Assicurarsi che l'impostazione sia stata 

configurata nel pannello di controllo della 

stampante (fare riferimento al manuale del 

produttore). 

 Per un collegamento seriale: le 

impostazioni della comunicazione 

seriale non sono corrette. 

Assicurarsi che le impostazioni di comunicazione 

tra il PC e la stampante siano le stesse (per le 

impostazioni di comunicazione seriale richieste 

dalla stampante, fare riferimento al manuale del 

produttore). 

 Il cavo seriale non è adatto. Assicurarsi che il cavo soddisfi i requisiti della 

stampante (fare riferimento al manuale del 

produttore). 

 In entrambi i casi (collegamento 

seriale o parallelo): 

Verificare la connessione. 

 



Stampa 

43 

- Il cavo è connesso alla porta 

sbagliata. 

 In entrambi i casi (collegamento 

seriale o parallelo): 

- Il cavo è connesso alla porta 

sbagliata. 

Verificare la connessione. 

   

Una pagina non viene 

stampata 

Per la stampa termica: il 

supporto di stampa è stato 

inserito nel modo sbagliato (la 

testina di stampa riscalda il lato 

sbagliato della carta. 

Reinserire il supporto nel modo corretto. 

 Per la stampa a trasferimento 

termico: il nastro non è stato 

inserito oppure è stato inserito 

nel modo sbagliato. 

Controllare il nastro e riposizionarlo se 

necessario (fare riferimento al manuale del 

produttore). 

 La modalità di stampa richiesta 

non è stata selezionata sulla 

stampante. 

Verificare che la modalità di stampa (termica o a 

trasferimento termico) sia stata selezionata 

correttamente sulla stampante (fare riferimento 

al manuale del produttore) oppure nella finestra 

di dialogo Configura stampa. 

Non è stato stampato 

un oggetto grafico 

(immagine, font di 

Windows, codice a 

barre ecc...). 

La memoria della stampante è 

esaurita. 

Verificare l'opzione Cancella memoria a 

stampa la prossima volta; se il problema 

persiste, verificare la quantità di memoria 

dedicata alle immagini (nella scheda Immagini 

del driver della stampante). 

 La stampante non ha abbastanza 

memoria. 

Aumentare la quantità di memoria della 

stampante aggiungendo una scheda di memoria 

extra oppure aumentando la RAM (fare 

riferimento al manuale del produttore oppure 

chiedere al rivenditore dal quale si è acquistata 

la stampante). 

 Alcune stampanti non 

riconoscono un oggetto se questo 

si sovrappone all'area 

stampabile, anche solo di pochi 

millimetri. 

Correggere la posizione dell'oggetto 

sull'etichetta. 

La stampante termica è 

inceppata 

Il supporto di stampa non è lo 

stesso di quello definito nella 

finestra di dialogo Imposta 

pagina (carta continua o con 

spazi). 

Verificare che durante l'impostazione della 

pagina sia stato selezionato il supporto di stampa 

corretto: Continuous, With gap. 
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